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Dialogs
Capture Professional uses the following dialogs:

Ask For Value Dialog

Hotkey Dialog

Print Dialog

Preferences Dialog

Registration Dialog

Save Dialog

Click on an item for help on that dialog.



Menus

Simply click on the menu item that you wish to know more about. If the item clicked on is a menu, that
menu appears in the place of this menu, allowing easy navigation through the menu system. Otherwise, a
popup will explain the menu items functionality.

This is the menu that will appear after capturing an image. A small subset of this menu exists when there
are not any image windows open.



Concepts
This topic covers the basics of Capture Professional in a somewhat theoretical perspective. For a more
practical view of how to use Capture Professional, see the How To section.

Capturing Basics:
Capture Professional works in three basic stages: Capturing, Touch Up and Output. In the
capturing stage, using the mouse selects the area of the screen to be captured. Touch Up is an
optional stage where the image can have special effects such as blurring or brightening applied to
the whole image. All Touch Up options are found under the Touch Up Menu. The output stage
can take many forms: printing the image on paper, copying to the clipboard or even to another
application or saving it as one of eight file types:

Bitmap -- .BMP,
Encapsulated Postscript -- .EPS,
GIF -- .GIF,
Icon -- .ICO,
JPEG -- .JPG,
PCX --.PCX,
TIFF -- .TIF,
or Targa --.TGA.

Capturing Direct To:
Capture Professional has the ability to capture imaged direct to all of the bolded items below. The
direct options are set in the Preferences Dialog. The Preferences Menu Item is found under the File
Menu. If one of the direct options is used, the image window will not be created for the image
unless the Create Windows radio button is checked (also found in the Preferences Dialog).

Application: Capturing directly to an application is one of Capture Professionals most potent
features. Capture Professional uses a proprietary mechanism to transfer images to another
application and does not use OLE or DDE. This means that it will work with most applications
that can handle graphics. There may be some applications that are incompatible with this process.
Care should be taken to ensure that the application that is linked to can support graphics.

Capturing directly to an application is most useful when using the hotkeys. The following example
illustrates this using any word processor that supports graphics. With Capture Professional, Word
or similar word processor, and the application that you want to capture images from running, press
one of the user-defined capture hotkeys. The word processor will temporarily disappear, clearing
the screen. The image is captured with a few mouse movements and clicks. The captured image
will automatically appear at the previous cursor location within the word processor. Move the
cursor to the next location and repeat.

Clipboard: Capture Professional can copy the captured image to the clipboard immediately after
being captured.

File: Capture Professional can copy the captured image directly to a file. This can be more
effective when combined with the AutoName feature. If the AutoName feature is used, the File
Save dialog will only appear on the first file save. All subsequent files will be named to the next
number in the sequence. If the AutoName feature is not used, the user will be prompted for a file
name for each image. The AutoName feature is set in the Save Dialog.

Printer: Capture Professional can copy the captured image directly to the current default printer.
The Print Dialog will appear with the last Left and Top offsets and Scale set to the previous images
values, if possible. This will allow the user to quickly click OK and print consistent images.

Capture Modes:
Capture Professional supports the image capturing modes below. The current mode, other than
Clipboard mode, is set in the Preferences Dialog. Additionally, hotkeys can directly invoke all
modes except Clipboard mode. See the discussion of hotkeys below. For specifics of how to use
each mode, see the How To section.

Client Area: Client Area mode captures a window on the screen, MINUS the menu, caption bar
and other non-client areas that will vary from application to application. If trying to capture a



control window (an edit box, list box, etc.), the Find Parent check box in the Preferences Dialog
should be unchecked.

Clipboard: Clipboard mode is only available when there is a device dependent bitmap on the
Windows clipboard. The Clipboard mode is accessed through the Edit Menu. Clicking on the
Capture from Clipboard Menu Item will copy the current image into a new image window.

Desktop: Desktop mode will capture the entire screen.

Icon: Icon mode is used to capture icons. Images captured in icon mode can only be saved in the
icon (.ICO) format. The icon format is unavailable for saving images captured by all other modes.

Rectangle: Rectangle mode captures a rectangular portion of the screen.

Region: Region mode captures a polygonal area of the screen. Since graphics formats are
rectangular in nature, Capture Professional saves the image as the smallest rectangle that can
encompass the polygon. The area of the rectangle not covered by the polygon is filled with a color
chosen in the Background Combo Box of the Preferences Dialog.

Window: Window mode captures a window on the screen, INCLUDING the menu, caption bar
and other non-client areas that will vary from application to application. If trying to capture a
control window (an edit box, list box, etc.), the Find Parent check box in the Preferences Dialog
should be unchecked.

Using the Timer:
Capture Professional can optionally use a timer for capturing images. When using the timer, the
image is captured as it would be without the timer. When the user portion of the capture operation
is completed the capturing of the image will be delayed by the length of the timer. This will allow
the inclusion of menus being pulled down and the screen being properly arranged. When using the
timer, the active applications cursor can also be captured if the Capture Cursor Check Box is
checked. These options are set in the Preferences Dialog.

Hotkeys:
Capture Professional has eight user-configurable hotkeys. Seven of the hotkeys can be disabled
and one can not be disabled. The hotkeys are configurable to allow for user preferences and to
avoid potential conflict with other applications hotkeys. There is a hotkey to invoke the current
capture mode set in the Preferences Dialog. There are six hotkeys to allow for directly accessing
the Client Area, Desktop, Icon, Rectangle, Region and Window Modes. The last hotkey will bring
Capture Professional to the top of the screen. These hotkeys are set in the Hotkey Dialog which is
accessed through the Preferences Dialog.

Voluntary vs. Involuntary Settings:
Capture Professional, in order to support a wide range of features and still be easy to use, uses two
types of settings: voluntary and involuntary.

Voluntary settings are set in the Preferences Dialog and the Hotkey Dialog. These settings are
written to the CAPTURE.INI file when the Save to .INI Push Button is pressed.

Involuntary settings are set in the Save Dialog and the Print Dialog. These settings use the last
value. For example, The user saves a 256 color JPEG file as C:\JPEG\img1.jpg. The next time the
Save Dialog is opened, the directory will be set to C:\JPEG, the number of colors will be set to 256
and the file type will be set to JPEG. Involuntary settings are saved to the CAPTURE.INI file
when the user exits Capture Professional.

AutoNaming:
Capture Professional can AutoName files. When the AutoName Checkbox in the Save Dialog is
checked, the static text box beneath it shows the AutoNamed file. If the file is APPL.BMP, the
static text box will have APPL####.bmp. This means that the last four characters of the file name
will be used in the sequencing. The sequence for this example will go. APPL.BMP -> APPL2.
BMP -> APPL3.BMP ->....->APPL9999.BMP.



The AutoNaming feature is only used when the Save Menu Item is chosen from the File Menu on
an image that has not previously been saved. AutoNaming does not affect the first image saved.
For example, APPL.BMP is not renamed to APPL1.BMP.

Choosing the Save As Menu Item or the Reset AutoName Menu Itemwill end the current sequence.
If an AutoNamed file will overwrite an existing file, a prompt will appear to overwrite the existing
file.



Contacting Creative Softworx
Creative Softworx can be contacted in the following manners:

By Phone: Call (800)430-WORX in the United States and (404)434-7182 if outside the United
States.

By Fax: Call (800)430-WORX in the United States and (404)434-7182 if outside the United States.

By Email: Send correspondence to 74011,206 on CompuServe and 74011.206@compuserve.com on
the internet.

By Mail:Send correspondence to:
Creative Softworx

2173-B Lake Park Drive
Smyrna, GA 30080

USA

Please feel free to contact us, if you have a problem or a question. If you have an idea for a new feature, we
especially want to hear from you -- if the feature fits well, it WILL be added.



Switch 2.0

Switch 2.0 is a useful printer utility that allows the user to quickly change printers. The user can pick the
printer that they wish by simply picking it out of the list on the system menu. However, Switch 2.0 allows
the user to change more than the current printer.

Switch 2.0 allows the user to change the orientation of the default printer by clicking on the icon.
Switch 2.0 allows the user to change the duplexing of the default printer also by clicking on the icon.

Switch 2.0 can even change which paper source the printer will use. This is incredibly useful if your printer
has multiple bins with different paper in each bin. For example if your printer has letterhead paper and
plain paper in different bins, you can switch this easily. You can also rename each bin to be more
descriptive. In the example, you could rename the Upper Tray
to Letterhead and the Lower Tray to Letterhead.

Switch 2.0 is fully configurable.

Switch 2.0 can even print all files dropped on its icon.



File Menu

Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Edit Menu

Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Touch Up Menu
Simply click on the menu item that you wish to know more about. If the item clicked on is a menu, that
menu appears in the place of this menu, allowing easy navigation through the menu system. Otherwise, a
popup will explain the menu items functionality. To go back to a previous menu, click on the Back button.



Zoom Menu
Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Window Menu
Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Help Menu
Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Save Menu Item
If the image window has bee previously saved, clicking on the Save Menu Item will save the current image
window. This will overwrite the file in the same file format, number of colors, and compression scheme, if
any. If the image was saved with the Save At Zoom option, it will save the image at the current zoom
factor.

If the AutoName option is not being used and the image window has not been previously saved, the Save
Dialog will appear. Under these conditions, this is identical to selecting the Save As Menu Item.

If the AutoName option is being used and the image window has not been previously saved, the file will be
automatically named to the next file name in the sequence. For example: FILE.BMP -> FILE2.BMP. The
file will be saved in the same file format, number of colors, and compression scheme, if any, of the first
image saved with the AutoName option. If the Save At Zoom option has been set, it will save the image at
the current zoom factor.



Save As Menu Item
Clicking on the Save As Menu Item will cause the Save Dialog to appear. The file specified in the Save
Dialog, will be saved using the image format, number of colors and compression scheme specified in that
dialog.



Reset AutoName Menu Item
Clicking on the Reset AutoName Menu Item will reset the AutoName function. This will cause the Save
Dialog to appear the next time Save or Save As is selected for an image that has not been saved. Otherwise,
the image will be saved as the next file name in the sequence.

The Reset AutoName menu item is only available (non-gray) when the AutoName option is used.



Print Menu Item
Clicking on the Print Menu Item will cause the Print Dialog to appear. This will allow the user to choose
how to print the current image.



Preferences Menu Item
Clicking on the Preferences Menu Item will cause the Preferences Dialog to appear. This will allow the
user to change all of the configurable options of Capture Professional.



Exit Menu Item
Clicking on the Exit Menu Item will cause Capture Professional to close. If there are images that have not
been saved or have been changed since they were saved, the following dialog will appear:Choosing YES will prompt the user to save each file that has not been saved or has changed since it was
saved.

Choosing YES will save the current image as if the Save Menu Item had been selected from the File Menu.
Choosing NO will cause the current image or its changes to be lost.
Choosing CANCEL will cause the exit to abort.

Choosing NO will exit the Capture Professional without saving any images.

Choosing CANCEL will abort the exit.



Undo Menu Item
Clicking on the Undo Menu Item will undo the last operation performed from the Touch Up Menu. If there
is an item to undo, this menu item will have the name of the operation appended to it. For example, if the
last operation performed was Blur, this menu item will be Undo - Blur.

This item is grayed out if there is not any action to undo.



Copy Menu Item
Clicking on the Copy Menu Item will copy the current image at the current zoom factor to the clipboard.



Capture From Clipboard Menu Item
Clicking on the Capture From Clipboard Menu Item will create an image window containing the current
bitmap in the clipboard.



Copy To Menu Item
This menu item is only available when an application has been linked to Capture Professional. In order to
find the application to link to, the Find Application Menu Item of the Edit menu or the Find App. button on
the Preferences Dialog is used.

After linking an application to Capture Professional, this menu item will read Copy To [Application Name]
. For example, if the link is with paintbrush, this menu item will read Copy To Paintbrush. Clicking on this
item will copy the image straight into the application.



Find Application Menu Item
Clicking on the Find Application menu item puts Capture Professional into Find Window Mode. In this
mode, the user chooses an application to link with Capture Professional. A hollow rectangle is drawn over
the application that the cursor is currently over. Pressing the left mouse button chooses the application that
currently has the hollow rectangle around it. If the link is successful, the user will be able to copy images
directly to that application.

Care should be taken in choosing the application to link to Capture Professional. The application MUST
support graphics and there is no way for Capture Professional to know if this is the case. It is also possible
that Capture Professional may cause erratic behavior in the application linked to it.



Capture! Menu Item
Clicking on the Capture! Menu Item will begin the screen capture process. Capture Professional will
capture an image in the mode specified in the Preferences Dialog.

For more information on the screen capture modes, see the Concepts section.



Add Menu
Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Blur Menu Item
The Blur Menu Item softens the appearance of an image by averaging 9 neighboring pixels to produce a
smoothed image with softened edges. It uses a threshold value entered into an Ask For Value Dialog. This
value ranges from 0 to 255, allowing smoothing without degrading the edges of the image. Blur changes a
pixel, only if its value differs from its neighbors value by greater than the threshold amount.



Brightness Menu
Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Contrast Menu Item
The Contrast Menu Item increases the contrast of the image by expanding its brightness range. It uses a
threshold value entered into an Ask For Value Dialog. This value ranges from 0 to 255. Pixel values less
than half of the entered value are set to black. Pixel values greater than (255 - half of the entered value) are
set to white. All other pixels are scaled accordingly.



Convert To Grayscale Menu Item
The Convert To Grayscale Menu Item converts a color image to a grayscale image. It uses the following
formula to determine the grayscale intensity:

gray = (.30 X red value of pixel + .59 X green value of pixel + .11 X blue value of pixel)

After an image is converted to grayscale, it should only be saved as a 256 color image for best results.



Equalize Menu Item
The Equalize Menu Item reassigns brightness levels of the image area so that the integral of the resulting
histogram increases linearly with brightness level. This is an effective way to brighten dark images.



Emboss Menu Item
The Emboss Menu Item will create an embossed effect. This is most effective on a grayscale image (See
Convert To Grayscale), but can produce an interesting effect on a color image.



Flip Menu

Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Invert Menu Item
The Invert Menu Item modifies the pixels in an image to create an effect similar to a photographic negative.



Outline Menu Item
The Outline Menu Item creates an outline around items in the image. This function is really an edge
detection filter. The brightness of the resulting pixels is proportional to the magnitude of the brightness
difference between adjacent pixels.



Posterize Menu Item
The Posterize Menu Item is a photographic effect that reduces the number of intensity levels in an grayscale
image. The resulting number of shades will be equally spaced throughout the brightness spectrum. The
number of shades remaining is entered into an Ask For Value Dialog. Valid values for posterization range
from 2 to 128.

This function will also work for color images, but the number of potential colors left will be the value
entered to the third power.



Remove Noise Menu Item
The Remove Noise Menu Item removes random noise from an image by replacing each pixels value with
the median of the 9-pixel area.



Rotate Menu

Simply click on the Menu Item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Sharpen Menu

Simply click on the Menu Item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Subtract Menu
Simply click on the menu item that you wish to know more about. To go back to a previous menu, click on
the Back button.



Blue Menu Item
The Blue Menu Item exists in both the Add Menu and the Subtract Menu. The value to be added or
subtracted is entered into an Ask For Value Dialog. Valid values for these operations range from 0 to 255.
This menu item is not available after an image has been converted to grayscale.



Green Menu Item
The Green Menu Item exists in both the Add Menu and the Subtract Menu. The value to be added/
subtracted is entered into an Ask For Value Dialog. Valid values for these operations range from 0 to 255.
This menu item is not available after an image has been converted to grayscale.



Change Menu Item
The Change Menu Item allows the change of brightness for all pixels. The value to be added or subtracted is
entered into an Ask For Value Dialog. Valid values for this operation range from -255 to 255. Negative
values darken the image and positive values brighten the image.



Gamma Brighten Menu Item
The Gamma Brighten Menu Item brightens an image using a gamma correction factor of 2.3.



HistoBrighten Menu Item
The HistoBrighten Menu Item changes an images brightness by generally reducing the number of brightness
levels present in the image. Contrast is improved, but details may be lost. HistoBrightening is often very
effective in bringing out the details of an image when the subject of interest is hidden in shadows.



Horizontal Menu Item
The Horizontal Menu Item flips an image as if it were viewed in a mirror.



Vertical Menu Item
The Vertical Menu Item flips an image upside-down.



Gentle Menu Item
The Gentle Menu Item sharpens an image by gently increasing the differences in brightness levels of
neighbor pixels. This menu item makes details of the image more visible, but may introduce noise.



Normal Menu Item
The Normal Menu Item sharpens an image by increasing the differences in brightness levels of neighbor
pixels. This menu item makes details of the image more visible, but may introduce noise.



100% Menu Item
The 100% Menu Item views the image at its original scale. Images copied to the clipboard will be copied at
this scale. Files saved using the Save At Zoom option will be saved at this scale.



50% Menu Item
The 50% Menu Item views the image at half of its original scale. Images copied to the clipboard will be
copied at this scale. Files saved using the Save At Zoom option will be saved at this scale.



200% Menu Item
The 200% Menu Item views the image at twice its original scale. Images copied to the clipboard will be
copied at this scale. Files saved using the Save At Zoom option will be saved at this scale.



400% Menu Item
The 400% Menu Item views the image at four times its original scale. Images copied to the clipboard will
be copied at this scale. Files saved using the Save At Zoom option will be saved at this scale.



Custom Menu Item
The Custom Menu Item views the image at the custom zoom factor set in the Set Custom Menu Item
Images copied to the clipboard will be copied at this scale. Files saved using the Save At Zoom option will
be saved at this scale.

The custom zoom factor is set for each individual image. The zoom factor for the current image will be
appended to the end of the menu item. For example if the custom zoom factor is 367% the menu item will
become Custom - 367%.



Set Custom Menu Item
The Set Custom Menu Item allows for setting the custom zoom factor of image via the Ask For Value
Dialog. Valid values range in 1% increments from 10% to 1000%.



Cascade Menu Item
The Cascade Menu Item stacks all open image windows and overlaps them so that each is the same size as
all others and only part of each underlying window is visible.



Tile Menu Item
The Tile Menu Item arranges open image windows from top to bottom so that they cover the entire width of
the desktop without overlapping one another.



Arrange Icons Menu Item
The Arrange Icons Menu Item rearranges any icons on the desktop. The rearranged icons are evenly spaced,
beginning at the lower left corner of the desktop. This command is useful if there are minimized image
windows when you resize Capture Professionals main window.



Close All Menu Item
The Close All Menu Item closes all open image windows. If there are images that have not been saved or
have changed since being saved, a prompt will be displayed for saving those images. See the File/Exit for
more details.



Contents Menu Item
The Contents Menu Item brings up the Contents section of the help file where the user will be shown the
main topics to view. Press the Contents button to see this screen.



Registration Menu Item
The Registration Menu Item brings up the Registration Dialog. The user information and password are
entered using this dialog.



About Capture Professional Menu Item
The About Menu Item displays the version information and copyright information in the About Dialog.



Save Dialog

The Save Dialog is used for saving the current image in the chosen file format.

Click on each control for information on that control.



Print Dialog

The Print Dialog is used for printing the current image.

Click on each control for information on that control.



Registration Dialog

The Registration Dialog is used for entering user information and password that are supplied after the
purchase of Capture Professional.

Click on each control for information on that control.



Ask for Value Dialog

The Ask For Value Dialog is used for query the values for certain image touch up functions as well as
setting the custom zoom factor.

Click on each control for information on that control.



About Dialog
The About Dialog displays version information about Capture Professional and it's two important DLLs.
This version information may be requested for technical support. It also displays copyright information.



Registering via CompuServe
Capture Professional can be registered quickly via CompuServe by following the simple steps below. This
information is effective August 1, 1994.

IF USING WINCIM:
1) Log onto CompuServe as you would normally.
2) Type GO SWREG to go to the SWREG forum.
3) Choose the Register Shareware option.
4) Read the notice and click on the Proceed push button.
5) Choose which region best describes the area of the world that Capture Professional should be

shipped to and press the OK push button.
6) Double click on the Registration ID line.
7) Enter 3154 on the Registration ID and press the OK Push Button.
8) Double click on Display Selected Titles.
9) You should see Capture Professional 1.0 in the list box.
10) Click on the Description push button.
11) Press the Register push button.
12) Enter all of the information in the Registration Information window.
13) Press Continue.
14) Press Send.
15) Your password information will arrive via CompuServe mail, usually within 12 hours. The manual

and additional materials should arrive within one week (US/CANADA only, other locations may
take longer).

IF NOT USING WINCIM:
The operation should be similar. The important thing to remember is that the registration ID is 3154.



Capture Professional Order Form - Click File/Print to Print.

Mail to:OR Call or Fax:
2173-B Lake Park Drive (800)430-WORX (US Only)
Smyrna, GA 30080 or (404)434-7182

Name: __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
__ __ __ __ __ __ __ __ __ __ (Print One Letter per Space)

Company: __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
__ __ __ __ __ __ __ __ __ __ (Print One Letter per Space)

Address: ____________________________________________________________
___________________________________Country__________________

Please Send Password Immediately Via:
____Fax: Fax Number:__________________________________________
____Email: Email Address:________________________________________
# Licenses Description Cost/License Total

Capture Professional $29.95
Switch 2.0 $15.00

_______________________________________________________________________
All Payment Must Be Made in US Funds. Total Order $__________
Call for multiple copy Georgia Residents Add 5% Sales Tax $ ______________
discounts! Orders Outside US/Canada Add $3.00 Shipping $ ______________

Final Total $__________
Method of Payment (Check One):
___ Check/Money Order [Make Payable to Creative Softworx]
___ Purchase Order [Please attach or fax]
___ Credit Card:

Master Card _____ VISA _____ Expiration Date: ____ / ____
Account #: __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
Bank of Issue:_________________Signature:______________________________

Optional Feedback Section:
On a Scale of 1 to 10, I rate Capture Pro. a: Low 1 2 3 4 5 6 7 8 9 10 High
If I could add one function, it would be:___________________________________
_______________________________________________________________________
Comments:_____________________________________________________________
_______________________________________________________________________



Pixelize Menu Item
The Pixelize Menu Item assigns the average color in a local square region to all pixels in that region. The
height and width of the square region is determined by the value returned from an Ask For Value Dialog.
Valid values range from 2 to 63.



Client Area Radio Button
The Client Area Radio Button is used to set Capture Professionals default capture mode to Client Area
mode.

See Concepts and How To for more information.



Desktop Radio Button
The Desktop Button is used to set Capture Professionals default capture mode to Desktop mode.

See Concepts and How To for more information.



Icon Radio Button
The Icon Radio Button is used to set Capture Professionals default capture mode to Icon mode.

See Concepts and How To for more information.



Region Radio Button
The Region Radio Button is used to set Capture Professionals default capture mode to Region mode.

See Concepts and How To for more information.



Window Radio Button
The Window Radio Button is used to set Capture Professionals default capture mode to Window mode.

See Concepts and How To for more information.



Find Parent Check Box
The Find Parent Check Box is used to modify the Window mode and Client Area modes to attempt to find a
parent with a window caption.

If this option is not checked, check boxes, radio buttons and other control windows will be selected for
capture. HINT: To select a window, move the cursor over the windows caption bar.

When this option is checked, only dialog boxes, popup windows, MDI windows and the main application
windows can be selected for capture.



Fixed Size Check Box
The Fixed Size Check Box is used to modify the Rectangle mode to move a non-sizable rectangle around
the screen instead of the normal sizable rectangle. The horizontal size of this non-sizable rectangle is set in
the X edit box and the vertical size is set in the Y edit box.



X Edit Box
The X Edit Box is used to enter the horizontal size of the rectangular selection area when the Fixed Size
check box is checked. Values must be 1 or greater.



Y Edit Box
The Y Edit Box is used to enter the vertical size of the rectangular selection area when the Fixed Size check
box is checked. Values must be 1 or greater.



Background Combo Box
The Background Combo Box chooses the color to fill in the background for region mode.



Use Timer Check Box
The Use Timer Check Box puts Capture Professional into timer mode when checked. In timer mode, the
actual screen capture is delayed by the amount in the Seconds edit box. This allows setting up the screen
(most notably menus) before the selected area of the screen is captured.



Capture Cursor Check Box
The Capture Cursor Check Box is used to include the cursor in the captured image. This option is only
available when the Use Timer check box is checked.



Seconds Edit Box
The Seconds Edit Box enters the time delay from when an area of the screen is selected and the capturing of
that area. Valid values range from 1 to 10.



Disabled Radio Button
The Disabled Radio Button disables the Capture Direct To feature. An image window is always created.
This is the default mode of operation.



Clipboard Radio Button
The Clipboard Radio Button causes images to be captured to be placed directly onto the clipboard.



Printer Radio Button
The Printer Radio Button causes capture images to be printed immediately after capture.



Application Radio Button
The Application Radio Button causes capture images to be copied directly to the application that has been
linked tom Capture Professional. See the How To section for details on how to set this up.



Create Windows Check Box
The Create Windows Check Box is used to modify the Capture Direct to Clipboard, Printer, Application and
File modes. When this check box is checked, an image window will be created in addition to the Capture
Direct to functionality.



Find Application Push Button
The Find Application Push Button is used to find an application to link to Capture Professional.

The user should be careful to select an application that can handle bitmaps.



Hide on Minimize Check Box
The Hide on Minimize Check Box, when checked, will cause Capture Professional to hide itself when the
minimize button of the main window is pressed.

To restore the window, use the Show Window Hotkey that is defined in the Hotkey Dialog.



Restore Window After Capture Check Box
The Restore Window After Capture Check Box, when checked, will cause Capture Professional to show the
main window after capturing an image, otherwise Capture Professional will reappear minimized (as an icon)
.



Keep Capture Pro. on Top Check Box
The Keep Capture Pro. on Top Check Box, when checked, will cause Capture Professionals main window,
dialogs, and icon to stay on top of all other windows.



Save to .INI Push Button
The Save to .INI Push Button, when pressed, will cause Capture Professional to save all of its settings in the
Preferences Dialog and Hotkey Dialog to the CAPTURE.INI file.



Use Default Values Push Button
The Use Default Values Push Button, when pressed, will cause Capture Professional to set all of the values
on the current dialog to the application default values.



Help Push Button
The Help Push Button brings up context sensitive help for each dialog.



Hotkey Dialog

The Hotkey Dialog sets Capture Professionals hotkeys. The application default values are pictured.

NOTE: If a particular hotkey does not work, another application may be using it. Try other hotkeys one is
found that works.

Click on each control for information on that control.



Preferences Dialog

The Preferences Dialog is used for setting Capture Professionals mode defaults. The application default
values are pictured.

Click on each control for information on that control.



Name Edit Box
The Name Edit Box is used to enter the name of the person who has purchased Capture Professional.

It is important to note that the name must be entered exactly as it is provided as the password is a unique
key against the name and company name. Changing either the name or the company name will cause the
password to fail and Capture Professional to run in demo mode.



Company Edit Box
The Name Edit Box is used to enter the company name of the person who has purchased Capture
Professional. If this is a personal copy, a company name like Personal Copy will be assigned.

It is important to note that the company name must be entered exactly as it is provided as the password is a
unique key against the name and company name. Changing either the name or the company name will
cause the password to fail and Capture Professional to run in demo mode.



Password Edit Box
The Password Edit Box is used to enter the password that is provided upon Capture Professionals purchase.
The password must be entered exactly.



Enable Capture Hotkeys Check Box
The Enable Capture Hotkeys Check Box, when checked, will allow the seven capture mode hotkeys to
function.

This will not affect the Show Window hotkey -- this cannot be disabled.



Invoke Default Capture Combo Box
The Invoke Default Capture Combo Box is used to choose the key that will cause Capture Professional to
begin the chosen default capture mode. This key is combined with the SHIFT and CONTROL keys.

This key is disabled if the Enable Capture Hotkeys Check Box is not checked.



Invoke Client-Area Capture Combo Box
The Invoke Client-Area Capture Combo Box is used to choose the key that will cause Capture Professional
to begin Client-Area capture instead of the chosen default capture mode. This key is combined with the
SHIFT and CONTROL keys.

This key is disabled if the Enable Capture Hotkeys Check Box is not checked.



Invoke Desktop Capture Combo Box
The Invoke Desktop Capture Combo Box is used to choose the key that will cause Capture Professional to
begin Desktop capture instead of the chosen default capture mode. This key is combined with the SHIFT
and CONTROL keys.

This key is disabled if the Enable Capture Hotkeys Check Box is not checked.



Invoke Icon Capture Combo Box
The Invoke Icon Capture Combo Box is used to choose the key that will cause Capture Professional to
begin Icon capture instead of the chosen default capture mode. This key is combined with the SHIFT and
CONTROL keys.

This key is disabled if the Enable Capture Hotkeys Check Box is not checked.



Show Window Combo Box
The Show Window Combo Box is used to choose the key that will cause the Capture Professional Window
to be displayed. This key is combined with the SHIFT and CONTROL keys.



Invoke Rectangle Capture Combo Box
The Invoke Rectangle Capture Combo Box is used to choose the key that will cause Capture Professional to
begin Rectangle capture instead of the chosen default capture mode. This key is combined with the SHIFT
and CONTROL keys.

This key is disabled if the Enable Capture Hotkeys Check Box is not checked.



Invoke Window Capture Combo Box
The Invoke Window Capture Combo Box is used to choose the key that will cause Capture Professional to
begin Window capture instead of the chosen default capture mode. This key is combined with the SHIFT
and CONTROL keys.

This key is disabled if the Enable Capture Hotkeys Check Box is not checked.



Invoke Region Capture Combo Box
The Invoke Region Capture Combo Box is used to choose the key that will cause Capture Professional to
begin Region capture instead of the chosen default capture mode. This key is combined with the SHIFT
and CONTROL keys.

This key is disabled if the Enable Capture Hotkeys Check Box is not checked.



File Name Edit Box
The File Name Edit Box is used to enter the file name to be saved.



File Name List Box
The File Name List Box is used to choose a file name to overwrite.



File Format Combo Box
The File Format Combo Box is used to choose the file format for the image to be saved.

If an image was captured as an icon, only the .ICO format will be available.



File Compression Combo Box
The File Compression Combo Box is used to specify optional compression schemes for the JPEG and TIFF
file formats. Otherwise, this combo box is filled with None.

Be certain to check to see if programs that use TIFF images can use TIFF images.



Directories List Box
The Directories List Box is used to navigate though the directory structure of the current drive. If a path is
not specified in the File Name edit box, the path in the Directories List Box will be used to save the file.



Drives Combo Box
The Drives Combo Box is used to choose the current drive. If a path is not specified in the File Name edit
box, the drive in the Drives Combo Box will be used to save the file.



Save at Zoom Factor Check Box
The Save at Zoom Factor Check Box, if checked, will cause the current image to be saved at its current
scale. Otherwise, it will be saved at its original size.



AutoName Check Box
The AutoName Check Box, if checked, will cause subsequent files to be automatically named to the next
highest number in the sequence when the Save menu item is used to save new images.



2 Color Radio Button
The 2 Color Radio Button, when checked, will cause the current image to be reduced to two colors before
being saved. The two colors are always black and white.

Capture Professional supports the following formats in 2 colors: Bitmap, PCX and TIFF.



16 Color Radio Button
The 16 Color Radio Button, when checked, will cause the current image to be saved using 16 colors. Images
that have more than 16 colors will be reduced accordingly -- image quality may suffer.

Capture Professional supports the following formats in 16 colors: Bitmap



256 Color Radio Button
The 256 Color Radio Button, when checked, will cause the current image to be saved using 256 colors.
Images that have more than 256 colors will be reduced accordingly -- image quality may suffer.

Capture Professional supports the following formats in 16 colors: Bitmap, Encapsulated Postscript, GIF,
JPEG, PCX and TIFF.



16.7M Color Radio Button
The 16.7M Color Radio Button, when checked, will cause the current image to be saved using 16.7 million
colors.

Capture Professional supports the following formats in 16.7 million colors: Bitmap, JPEG and Targa.



Normal Radio Button
The Normal Radio Button, when checked, will cause the current image to be printed normally. If the image
is in color and the printer supports it, the image will be printed in color.

This is the fastest print mode.



B&W Halftone Radio Button
The B&W Halftone Radio Button, when checked, will cause the current image to be printed in black and
white using the halftone technique. The halftone technique prints images in gray tones by varying the side
of the dots that make up the halftone pattern.

The halftone method is well suited for document reproduction. The result is a picture that is similar to a
halftone picture printed in a newspaper.



B&W Scattered Radio Button
The B&W Scattered Radio Button, when checked, will cause the current image to be printed in black and
white using the scatter technique. The scatter technique simulates 256 shades of gray by varying the
distance between printed dots.

The scatter method prints pictures of higher apparent resolution than the halftone method and produces very
high quality laser prints.



Center Horizontal Push Button
The Center Horizontal Push Button, when pushed, will horizontally center the image to be printed on the
paper by setting the Left Edit Box accordingly.



Center Vertical Push Button
The Center Vertical Push Button, when pushed, will vertically center the image to be printed on the paper
by setting the Top Edit Box accordingly.



Left Edit Box
The Left Edit Box will allow the user to enter the offset from the left edge of the page. This value is entered
in inches if the inches Radio Button is checked and centimeters if the cm Radio Button is checked.



Left Static Text Box
The Left Static Text Box indicates the minimum and maximum offset from the left edge of the page to keep
the image, at the given scale, completely on the page. These values are displayed in inches if the inches
Radio Button is checked and centimeters if the cm Radio Button is checked.



Top Edit Box
The Top Edit Box will allow the user to enter the offset from the top edge of the page. This value is entered
in inches if the inches Radio Button is checked and centimeters if the cm Radio Button is checked. These
values are displayed in inches if the inches Radio Button is checked and centimeters if the cm Radio Button
is checked.



Top Static Text Box
The Top Static Text Box indicates the minimum and maximum offset from the top edge of the page to keep
the image, at the given scale, completely on the page.



Width Edit Box
The Width Edit Box allows the user to enter the width, provided that it is in the range of the Width Static
Text Box. Changing the width will automatically change the height and scale. This value is entered in
inches if the inches Radio Button is checked and centimeters if the cm Radio Button is checked.



Width Static Text Box
The Width Static Text Box indicates the minimum and maximum values for the width that will keep the
image on the page. To increase the maximum range, the value of the left offset should be decreased. These
values are displayed in inches if the inches Radio Button is checked and centimeters if the cm Radio Button
is checked.



Height Edit Box
The Height Edit Box allows the user to enter the height, provided that it is in the range of the Height Static
Text Box. Changing the height will automatically change the width and scale. This value is entered in
inches if the inches Radio Button is checked and centimeters if the cm Radio Button is checked.



Height Static Text Box
The Height Static Text Box indicates the minimum and maximum values for the height that will keep the
image on the page. To increase the maximum range, the value of the top offset should be decreased. These
values are displayed in inches if the inches Radio Button is check and centimeters if the cm Radio Button is
checked.



Scale Edit Box
The Scale Edit Box allows the user to enter the scale (the number of pixels on the printer per pixel of the
image). This value must be within the range displayed in of the Scale Static Text Box. Changing the scale
will automatically change the width and height. This value is independent of the units value indicated by
the inches and centimeters radio buttons.

The Scale Edit Box is important as it allows the user to enter the same scale value for printing multiple
images so that the proportions between the images are maintained. Note that the scale value for one printer
may not correspond to the same width and height on another.



Scale Static Text Box
The Scale Static Text box indicates the minimum and maximum values for the scale that will keep the
image on the page. To increase the maximum range, the value of the left and top offsets should be
decreased. These values are independent of the units value indicated by the inches and centimeters radio
buttons.



cm Radio Button
The cm Radio Button, when checked will convert all units in the Left, Top, Width and Height edit and static
text boxes as well as the page size static text box to centimeters.



inches Radio Button
The inches Radio Button, when checked will convert all units in the Left, Top, Width and Height edit and
static text boxes as well as the page size static text box to inches.



Custom Value Edit Box
The Custom Value Edit Box allows the user to enter a value in Ask For Value Dialog. This value must be
within the range given in the static text box to the right of the Custom Value Edit Box.



Red Menu Item
The Red Menu Item exists in both the Add Menu and the Subtract Menu. The value to be added or
subtracted is entered in an Ask For Value Dialog The valid values range from 0 to 255. This menu item is
not available after an image has been converted to grayscale.



Clockwise Menu Item
The Clockwise Menu Item will rotate the image 90 degrees clockwise. The horizontal and vertical aspects
of the image will be switched which may require the image window to be resized to effectively view the
image.



Counter-Clockwise Menu Item
The Counter-Clockwise Menu Item will rotate the image 90 degrees counter-clockwise. The horizontal and
vertical aspects of the image will be switched which may require the image window to be resized to
effectively view the image.



Rectangle Radio Button
The Rectangle Radio Button is used to set Capture Professionals default capture mode to Rectangle mode.

See Concepts and How To for more information.



File Radio Button
The File Radio Button causes captured images to be saved immediately after capture.



Print Preview Window
The Print Preview Window serves to show the relationship of the image being printed to the paper that it is
printed on. The image will move as the left and top offsets are changed and will size as the width, height
and scale are changed.

Note: If the scale is too small, the image may not be visible on the page.



Registration Benefits
Once payment is received for Capture Professional the following items will be sent to the purchaser.

The password that disables Registration Dialog on start up and the banner that is appended to the
bottom of all images saved, copied or printed will be provided by fax or Email.

The most recent version of Capture Professional (enhanced/added features and fixes).

An informative manual.

Registration also conveys the following benefits upon the user.

Free minor upgrades if downloaded from CompuServe, America Online, BBS, etc. If requested
directly from Creative Softworx, a $3.00 fee ($5.00 outside the US and Canada) is required to
handle shipping and handling.

Free technical support via (800)430-WORX.

Notification of major upgrades (at reduced prices).



How To...
For more background information, see the Concepts Section.

Capture an Image:
Images are captured in seven different modes. Each mode works in its own way. All modes except
Clipboard and Desktop can be canceled by pressing the escape key before completing the Capture
operation.

Client Area: Either set the Default Capture Mode to Client Area in the Preferences Dialog and

click on the Capture! Menu Item or use the Client Area Hotkey. The cursor will turn into aand the client area of the window that the cursor is over will be inverted. Move the cursor over the desired
window. When the left mouse button is pressed, the client area is captured, either immediately or optionally
after the duration of the timer.

Clipboard: Click on the Capture from Clipboard Menu Item in the Edit Menu. This creates an image
window with the bitmap contents of the clipboard.

Desktop: Either set the Default Capture Mode to Desktop in the Preferences Dialog and click on the
Capture! Menu Item or use the Desktop Hotkey. The desktop is captured without user input, either
immediately or optionally after the duration of the timer.

Icon: Either set the Default Capture Mode to Icon in the Preferences Dialog and click on the

Capture! Menu Item or use the Icon Hotkey. The cursor will turn into a. When the left mouse button is pressed. a 32 by 32 rectangle can be moved around the screen. When the
image to be captured is covered by the rectangle, release the left mouse button. The icon is captured
immediately or optionally after the duration of the timer.

Rectangle: Either set the Default Capture Mode to Rectangle in the Preferences Dialog and click on the
Capture! Menu Item or use the Rectangle Hotkey. The cursor will turn into a.

If the Fixed Size Check Box in the Preferences Dialog is not checked, the first point is set by moving the
cursor to any corner of the rectangle to be captured. Draw the rectangle by holding the left mouse button
down and dragging the cursor to the opposite corner of the rectangle being captured. The rectangle can be
moved in its present size by holding down the right mouse button with the left mouse button. When the
image to be captured is covered by the rectangle, release the left mouse button. The rectangle is captured
immediately or optionally after the duration of the timer.

If the Fixed Size Check Box in the Preferences Dialog is checked, a rectangle of fixed size will
appear when the left mouse button is first pressed. This size is set in the X Edit Box and Y Edit
Box which are also in the Preferences Dialog. When the image to be captured is covered by the
rectangle, release the left mouse button. The rectangle is captured immediately or optionally after
the duration of the timer.

Region: Either set the Default Capture Mode to Rectangle in the Preferences Dialog and click on
the Capture! Menu Item or use the Rectangle Hotkey. The cursor will turn into a. Set the first point of the polygon by pressing the left button at that location. Release the left mouse
button. As the cursor is moved, a line will be drawn from the first point to the cursor. Set each subsequent
point by pressing the left mouse button down and releasing it when the cursor is at the desired location. The
polygon can be moved by holding down the right mouse button while moving the mouse. Double click on
the final point or hold down the SHIFT key and click the left mouse button down on the final point ends the
region capture mode. The polygon will then be captured immediately or optionally after the duration of the
timer.

Window: Either set the Default Capture Mode to Window in the Preferences Dialog and click on
the Capture! Menu Item or use the Window Hotkey. The cursor will turn into aand the window that the cursor is over will be inverted. Move the cursor over the desired window. When
the left mouse button is pressed, the window captured, either immediately or optionally after the duration of
the timer.

Capture Directly to Another Application:
Capture Professional can copy images directly to another application, but this requires some user
setup to initiate this.



1) In the Preferences Dialog, press the Find App. Push Button OR select the Find
Application Menu Item from the Edit Menu.

2) The cursor will change to a. The application that the cursor is over will have an inverted border around it.
3) Move the cursor of the application to be linked to and once the application has the inverted border
around it press the left mouse button.
NOTE: Be certain to ensure that the application being linked to can support graphics. This may not work
with all applications.

4) Capture an image.

5) To copy the image to the application, press the Copy To [Application Name] Menu Item in the Edit
Menu.

Capture a Menu:
In order to capture a menu, the timer must be used. The timer and its duration are set in the
Preferences Dialog.

1) Capture the area that the menu would appear. If capturing a window with a menu, use the
Window mode.

2) A sound will let the user know that the area has been set. Quickly pull down the menu
desired.

3) When the timer expires, the area will be captured with the menu visible.
NOTE: If the Capture Cursor Check Box is checked, the cursor can be shown over the menu

being captured. Be certain to carefully place the cursor.

Capture a DOS Screen:
Capture Professional can capture any DOS screen that can be run in a DOS Window.
1) Run Capture Professional.
2) Run your DOS application.
3) If the DOS application is full screen, hold down the ALT key and press SPACE.
4) The DOS application should now be in a window. If it is not, Capture Professional will

not work with this DOS application.
5) Do a Client Area capture. This can be done by setting Capture Professional to Client

Area Mode in the Preferences Dialog or using the Client Area Hotkey.



Disclaimer

Use of Capture Professional indicates agreement to the
following -- please read carefully.
Creative Softworx believes that the software will perform substantially in accordance with the
documentation and that the diskettes and documentation are free from defects in materials and
workmanship.

If you discover defective diskette or documentation we will replace them upon notification. If the software
does not perform as documented, we will attempt to correct and replace it within a reasonable period of time
after receipt of written notification describing the problem.

Creative Softworx specifically disclaims all warranties, including, without limitation, all implied or inferred
warranties of merchantability, fitness for a particular purpose, and non-infringement of third party rights. It
is your responsibility to determine the fitness of the product for any particular purpose.

Under no circumstances will Creative Softworx be liable for special, incidental, consequential, indirect or
any other damages or claims arising from the use of this product, including loss of profits or any other
commercial damages, even is Creative Softworx has been advised of the possibility of such damages.




